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1. Assessment Creation Overview 
 

ItemBank is designed for use in both paper-based and onscreen assessments; however, this guide 
is intended for use with paper-based assessments only. An assessment is a question paper and its 
associated marking instructions. 
 

Principal Assessors will use ItemBank to: 

• select items to include in a question paper 

• decide on the order that items should appear in the question paper 

• preview the complete question paper and marking instructions in advance of the Assessment 
Review Meeting. 

 

An overview of the Assessment Creation process is detailed below: 
 

Step 1: Log in to ItemBank 

 

Step 2: ‘Check Out’ the Assessment Version 

 

Step 3: Search through items in the item bank & select specific items to include in the question 
paper 

 

Step 4: View the ‘Printed Assessment’ (ie the complete question paper and marking instructions) 

 

Step 5: If necessary, reselect items for the question paper and/or change the order in which 
items appear in the question paper 

 

Step 6: If necessary, make/mark up any minor amendments required to the question paper and 
marking instructions & upload to ItemBank 

 

Step 7: E-mail SQA’s NQ Assessment team to advise that the question paper and marking 
instructions are now ready.  

 

Step 8: SQA’s NQ Assessment team will issue paper copies of the question paper and marking 
instructions to the Question Paper Reviewers, the Principal Assessor, and the Qualifications 

Manager/Officer. 

 

Step 9: Assessment Review Meeting held, and any changes are made to the question paper and 
marking instructions. 

 

Step 10: Reviewed Assessment approved. 
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2. Getting Started 
 
(a) Computer Specification 
 
Your computer must meet the following minimum specifications to run ItemBank. 
 

Processor 2.33GHz Single core CPU 
Or 
1.2GHz Dual core CPU 
 

Memory 1GB 
 

Display Screen resolution of 1024 x 768 
Graphics card with at least 64MB of memory 
 

Internet Browser 
 

Surpass Viewer* 

Microsoft Word 2007 or above 
 

 
*See Surpass Viewer installation guide for ItemBank. 
 
(b) Key Contacts 
 

Activity Contact Telephone/e-mail 

Using ItemBank 
Username/password 
queries 
 

NQ Assessment 
 

question.papers@sqa.org.uk 
0345 213 6807 
 

Subject support & advice Qualifications Manager 
Qualifications Officer 

 

 
(c) Security 
 
Please refer to Section 2 - Security of confidential materials in the Guidance for Producing and 
Quality Assuring Items, Question Papers and Marking Instructions for a note of security procedures 
which must be followed when using ItemBank. You can access this guidance via the Appointee 
Portal. 
  

https://www.sqa.org.uk/sqa/files_ccc/sqa-surpass-viewer-installation-guide-itembank.pdf
mailto:question.papers@sqa.org.uk
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3. Logging In and Homepage 
 
(a) Logging In 
 
You will be sent an e-mail from question.papers@sqa.org.uk detailing the address for logging in to 
ItemBank and your username. You will be sent an auto-generated e-mail from ItemBank containing 
your password. 
 

• Follow the link in the e-mail. 

• Enter your username and password. Please note the password is case sensitive. 
 

 
 

• Click ‘Log In’. 
 
(b) System Lock 
 
After a period of inactivity, ItemBank will lock you out and you will have to re-enter your password. 
 

 
 

• Enter your password and click ‘Log In’ to continue working in ItemBank. 
  

mailto:question.papers@sqa.org.uk
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(c) Homepage 
 
This is the ItemBank homepage. 
 

Home   Assessment Version Management  Log Out 

 

 
 

 Change My Details Change My Password 

 

• Clicking on any of the tabs along the top of the page will take you to the relevant screen - 
‘Home’ or ‘Assessment Version Management’. 

• To log out of ItemBank use the ‘Log Out’ button at the top of the screen. 

• To change any of your details (name or e-mail address) use the ‘Change My Details’ button at 
the bottom of the screen. 

• To change your password, use the ‘Change My Password’ button at the bottom of the screen. 
When you first log in to ItemBank you should change your password. 
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4. ‘Check Out’ the Assessment Version and Select 
Items 

 
(a) The Assessment Version Management tab 
 

• Click on ‘Assessment Version Management’ to access the Assessment Version Management tab. 
 

 
 
An ‘Assessment Version’ refers to a question paper for a specific year. 
Within this tab you should see a list of any question papers for which you are responsible. Please 
get in touch with NQ Assessment if you do not see your question papers. 
The Assessment Version Name column will indicate the year of the question paper. 
 

• If necessary, the Assessment Version Name column can be expanded by clicking and dragging 
the column edge. 

 

  Assessment Version Name 

 

  
 
 

  Check-Out Edit Assessment Version 

 

• To edit an Assessment Version first select it from the list (it will then be highlighted in blue). 

• Click ‘Check-Out’. 

• Click ‘Edit Assessment Version’.  
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(b) Editing Assessment Versions 
 
You will then be presented with the Edit Assessment Version screen. 
 

 
 

 Item IDs 

 
The structure of the question paper will be reflected in the layout of this screen, ie, you will see 
if it is split into separate sections. If the question paper is not split into separate sections, you 
will see just one section.  
 
In the example above, the question paper has a Section 1 and a Section 2. 
 
Note: when you first start working on a question paper, it may look as if some items have already 
been selected for the question paper (as indicated by ‘Item IDs’). These ‘items’ are in fact 
standardised text that has been set up by SQA to appear in your question paper. For example, the 
‘Item IDs’ shown in the screen above refer to the following text which has already been inserted: 
 

 
 

 
Note: You must not edit/delete these existing items.  

Section 1 Heading 

End Section 1 
 
 
Section 2 Heading 

End Section 2 

End of Question Paper 



 
Version 2.4 Page 11 

• To select items for a section in the question paper, first select a section (it will then be 
highlighted in pink) and then click ‘Add’. 

 

 
 

 Add 

 
You will then be presented with the Fixed Section screen. 
 

 Search Items 

 

 
 
This is the screen which allows you to search through the bank for specific items you want to 
include in the question paper. To search for items, click on ‘Search Items’. 
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(c) Carrying out a simple search in ItemBank 
 

• To start searching for items click ‘Create Parameter’. 
 

 Create Parameter 
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 Select Type Select Projects Select Reference Select Value 

 

  
 

 

 Available Items Create Done 

 

• Select ‘Fixed Ref’ from the ‘Select Type’ drop-down menu. 

• Select your subject by checking the checkbox in the ‘Select Projects’ menu. 

• Select a metadata field by clicking on the row in the ‘Select Reference’ menu. 

• Select a value from the ‘Select Value’ drop-down menu. 
 
‘Available Items’ will display the number of items that match the criteria specified. 
 

• Click ‘Create’. 

• Click ‘Done’. 
 
Note: For other methods of searching for items in ItemBank please see the Appendix – Search 
Parameters section (page 31).  
 
After clicking on ‘Done’ you will return to the Fixed Section screen where you will see the Search 
Parameters you have applied and the Search Results 
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 Search Parameters Search Results Edit Parameter 

 
 

 Match all parameters Match any parameter Remove 

 
(d) Narrowing down or amending your search in ItemBank 
 
If your search has returned many items, then you may want to narrow down your search further 
before looking at items that have been returned in the search.  You can do this by applying multiple 
parameters. 
 

• To apply another parameter to a simple search simply repeat the steps for carrying out a 
simple search using your additional search parameters. 

• These parameters can be combined using either ‘Match all parameters’ or ‘Match any 
parameters’, ie, the results will be based on a match from all the parameters combined or a 
match from any of the individual parameters. 

 
If your search did not find the items that you wanted, then you may want to amend your search. 
 

• To edit a parameter, select the parameter row in the Search Parameters box (it will then be 
highlighted in blue), then click ‘Edit Parameter’. 

• To remove any parameters, click on the red ‘Remove’ cross beside the entry in the Search 
Parameters section. 
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(e) Item Search Results 
 
The items that have been returned in your search will appear in the Item Search Results table on 
the screen. 
 

 
 

Item Rows Selected Items Preview Item Select Item 

 

• The Item Search Results can be sorted by clicking on any of the ‘Column Headings’ once. 
Clicking again on the ‘Column Headings’ sorts the results in the opposite order.  

• If you wish to view the content of a specific item before deciding whether to select it for the 
question paper, select the ‘Item Row’ and click ‘Preview Item’. 

• The item will now download. 

• Close the blank browser tab that has appeared. 

• An icon will appear in the Surpass Viewer window to indicate when the item has downloaded. 
 

 
 

• Click the arrow icon to open the file in Microsoft Word. Close Word when you have finished 
looking at the item. 

 
Note: Files are automatically downloaded to C:\Users\USERNAME\Downloads where USERNAME is 
your computer username. You must delete the item from this folder once you have finished. 
 

• If you wish to select one of the items for the question paper, select the ‘Item Row’ and click 
‘Select Item’. Repeat this to select further items. 

• The item(s) you have selected for the question paper will appear in the Selected Items section 
which can be accessed by clicking ‘Selected Items’. 
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(f) Arranging Selected Items 
 

 Name Column 

 

 
 

Item Rows Up Down Preview Item Remove Item 

 

• If you wish to view one of the items that you have selected, select the ‘Item Row’, and click 
‘Preview Item’. 

• The item will now download. 

• Close the blank browser tab that has appeared. 

• An icon will appear in the Surpass Viewer window to indicate when the item has downloaded. 
 

 
 

• Click the arrow icon to open the file in Microsoft Word. Close Word when you have finished 
looking at the item. 

 
Note: Files are automatically downloaded to C:\Users\USERNAME\Downloads where USERNAME is 
your computer username. You must delete the item from this folder once you have finished. 
 

• If you want to change the order that items will appear in the question paper, select the ‘Item 
Row’, and use the ‘Up’ and ‘Down’ arrow buttons.  

 
Note: Please remember that the question paper will be set up by SQA with items that contain 
standardised text.  Any such items can be easily identified using the ‘Name Column’. You must 
ensure that these items appear in the correct positions, ie, Section 1 Heading should be the first 
item in the list and End Section 1 should be the last item in the list. 
 

• If you wish to delete one of the items that you have selected, select the ‘Item Row’, and 

click ‘Remove Item’.  
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• If you need to return to carry out a further search for an item, click ‘Search Items’. 
 

 Search Items 

 

 
 

 OK 

 

• Once you have selected and arranged all the items click ‘OK’. 
 
You will return to the Edit Assessment Version screen. 
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 OK 

 
Note: If your question paper has more than one section, you should repeat this item selection 
process for the other sections.  Return to the Editing Assessment Versions section (page 10). 
 
Once you have selected all items for all sections of the question paper click ‘OK’.  
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5. Viewing the Assessment 
 

• Click on the ‘Printed Assessment’ button in the Assessment Version Management tab. 
 

  
 

 Printed Assessment 

 

• Click on the question paper that you are currently working on in the Printed Assessments box. 
 

  
 

 Generate 

 
 



 
Version 2.4 Page 20 

(a) Question Paper 
 

• Click on the Generate button next to Assessment Paper. 
 

You will then be presented with the Generate (Assessment Paper) window. 
 

 
 

 Choose template OK 

 

• In the ‘Choose template’ drop down menu select the correct booklet template. The booklet 
template will be: 
o Level Paper Assessment Templates – Structured Booklet (a question/answer booklet) 
o Level Paper Assessment Templates – Unstructured Booklet (a question only booklet) 
o Level Paper Assessment Templates – Transcript or Word List Booklet (a transcript or word 

list). 

• Insert a comment in the Comments text box (eg, Version 1) and click ‘OK’. A comment is 
mandatory – it cannot be left blank, otherwise you cannot click ‘OK’. (Please do not use the & 
symbol in the comment box as this causes an error to occur.) 

 
The following will appear in the Assessment Paper section. 
 

 
 

 Download 

 

• To view the question paper, click ‘Download’. 

• The file will now download. 

• Close the blank browser tab that has appeared. 

• An icon will appear in the Surpass Viewer window to indicate when the file has downloaded. 
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• Click the arrow icon to open the file, a compressed (zipped) folder. 

• Within this folder you will see the Microsoft Word document. The file title will be the name of 
the question paper followed by Exam Paper and then the version number, eg, 2012 Fashion 
and Textile Technology Int 2_Exam Paper_1.docx 

• You can then open this file in Word. 
 
Note: Files are automatically downloaded to C:\Users\USERNAME\Downloads where USERNAME is 
your computer username. You must delete the question paper from this folder once you have 
finished. 
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(b) Marking Instructions 
 

• Return to the Printed Assessment screen in ItemBank. 
 

 
 

 Generate 

 

• Click on the ‘Generate’ button next to Mark Scheme. 
 
You will then be presented with the Generate (Mark Scheme) window. 
 

 
 

 Choose template OK 

 

• In the ‘Choose template’ drop down menu select Level Paper Assessment Templates - Marking 
Instruction Booklet. 
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• Insert a comment in the Comments text box (eg, Version 1) and click ‘OK’. A comment is 
mandatory – it cannot be left blank, otherwise you cannot click ‘OK’. (Please do not use the & 
symbol in the comment box as this causes an error to occur.) 

 
The following will appear in the Mark Scheme section. 
 

 
 

 Download 

 

• To view the marking instructions, click ‘Download’. 

• The file will now download. 

• Close the blank browser tab that has appeared. 

• An icon will appear in the Surpass Viewer window to indicate when the file has downloaded. 
 

 
 

• Click the arrow icon to open the file, a compressed (zipped) folder. 

• Within this folder you will see the Microsoft Word document. The file title will be the name of 
the marking instruction followed by Mark Scheme and then the version number, eg, 2012 
Fashion and Textile Technology Int 2_Mark Scheme_1.docx 

• You can then open this file in Word. 
 
Note: Files are automatically downloaded to C:\Users\USERNAME\Downloads where USERNAME is 
your computer username. You must delete the marking instruction from this folder once you have 
finished. 
 

• Once you have viewed the question paper and marking instructions proceed to the Amending 
the Assessment section on page 24 if you require any amendments.  
 

• If no amendments are required proceed to the Completing the Assessment section on page 30. 
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6. Amending the Assessment 
 
(a) Reselecting or Rearranging Items 
 
Once you have viewed the complete assessment, you can reselect or rearrange any items if 
necessary (instructions for viewing the assessment can be found in the Viewing the Assessment 
section (page 19)). 
 

• Close Microsoft Word and return to the Printed Assessment screen in ItemBank. 
 

 
 

 Close 

 

• Click ‘Close’ to close the Printed Assessment screen. 
 
You will then return to the Assessment Version Management tab. 
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 Edit Assessment Version 

 

• To edit an Assessment Version first select it from the list (it will then be highlighted in blue). 

• Click ‘Edit Assessment Version’. 
 
You will then return to the Edit Assessment Version screen. 
 

 
 

 Add 

 

• To reselect or rearrange items, select the section (it will then be highlighted in pink) and 

then click ‘Add’.  
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You will then return to the Fixed Section screen. 
 

 
 

Item Rows Up Down Preview Item Remove Item 

 

• If you wish to view one of the items before rearranging or reselecting, select the ‘Item Row’ 
and click ‘Preview Item’. 

• The item will now download. 

• Close the blank browser tab that has appeared. 

• An icon will appear in the Surpass Viewer window to indicate when the item has downloaded. 
 

 
 

• Click the arrow icon to open the file in Microsoft Word. Close Word when you have finished 
looking at the item. 

 
Note: Files are automatically downloaded to C:\Users\USERNAME\Downloads where USERNAME is 
your computer username. You must delete the item from this folder once you have finished. 
 

• To change the order of the items in the question paper select the ‘Item Row’ and use the ‘Up’ 
and ‘Down’ arrow buttons. 

• To delete one of the items that you previously selected, select the ‘Item Row’ and click 
‘Remove Item’. 
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 Search Items 

 

 
 

• To return to carry out a search for a replacement item click ‘Search Items’. 
 
Instructions for searching for items can be found in the Carrying out a simple search in ItemBank 
section (page 12). 
 
Once you have reselected and/or rearranged your items, instructions for viewing a revised 
question paper and marking instructions can be found in the Viewing the Assessment section (page 
19). 
 
 
(b) Amending Content 
 
Once you have viewed the complete assessment, you may notice that minor amendments to the 
content or layout are required.  Instructions for viewing the assessment can be found in the 
Viewing the Assessment section (page 19). 
 
Minor amendments can be made as required. Alternatively, comments can be added to indicate 
where amends are required.  The NQ Assessment team will use these comments to make the 
required amends. 
 
Note: Please ensure you are happy with the items selected and the order in which they appear 
before any minor amendments are added. 
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 New Comment Highlighted Text 

 

• To mark up minor amendments on the question paper or marking instructions, highlight the 
text you wish to change, or position the cursor where you need the layout changed and select 
‘New Comment’ from the ‘Review’ menu. 

• Enter the amendment or instruction in the comment box. 
 

• Select ‘Save As’ from the ‘File’ menu and save the amended question paper or marking 
instructions to your computer. Remember the filename and the folder where you have saved 
the question paper or marking instruction to. 

• Close Word and return to the Printed Assessment screen in ItemBank. 
 

 
 

 Upload 

 

• Click ‘Upload’ in either the Assessment Paper or Mark Scheme section. 
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 OK Browse 

 

• Click ‘Browse’ and navigate to where you saved the question paper or marking instructions on 
your computer. 

• Insert a comment in the Comments text box (eg, Version 2) and click ‘OK’. A comment is 
mandatory – it cannot be left blank, otherwise you cannot click ‘OK’. (Please do not use the & 
symbol in the comment box as this causes an error to occur.) 

 
Note: Following this, you must delete the question paper and marking instructions from your own 
computer. 
 

 
 

 Close 

 

• Click ‘Close’ to close the Printed Assessments screen. 
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7. Completing the Assessment 
 
When you are happy that the question paper and marking instructions are ready for the Assessment 
Review meeting, make sure you are in the Assessment Version Management tab. 
 

 
 

 Check-In 

 

• Select the question paper from the list (it will then be highlighted in blue) then click ‘Check-
In’. 

• Notify the NQ Assessment team (question.papers@sqa.org.uk) that you have checked-in the 
assessment ready for the Assessment Review meeting. 

 
Note: NQ Assessment Staff will carry out any marked-up changes before the question paper and 
marking instructions are printed and distributed in advance of the Assessment Review meeting. 
  

mailto:question.papers@sqa.org.uk
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8.  Appendix – Search Parameters 
 
There are 7 types of search parameters that are appropriate for Principal Assessors to use for 
paper-based assessments within ItemBank. 
 

Parameter When to use it? Example 

Fixed Ref When you want to search for a 
specific value in a specific 
metadata field. 

You want to search the metadata field 
‘Total Mark’ for values equal to 10.  

Free Text When you want to search for 
specific text in a specific 
metadata field 

You want to search the metadata field 
‘Keywords’ to find out if any items have 
the keyword ‘bar chart’. 

Free Text – 
Year Coding 

When you want to filter out items 
used in a particular year or years. 

You are choosing your items for the 2016 
assessment and do not want to choose any 
items used in 2015 or 2014. 

Specific Item When you are looking for a 
specific item.   
 

You want to choose a specific item. 

Item Name When you want to search for 
items that contain any specific 
text in the name of the item.  
 

You want to search for items written by a 
specific writer (the writer’s initials will 
form part of the item title so you can use 
their initials to search).   

Folder 
Reference 

When you want to search for 
items stored in a specific folder in 
ContentProducer.   
 

You want to search for items written by a 
specific writer (as all items written by a 
writer will be stored in their own folder). 

Workflow 
Status 

When you want to see all 
available items in the bank. 

You want to choose from all available 
items in the bank. 
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(a) Fixed Ref 
 

 Select Type Select Projects Select Reference Select Value 

 

  
 

 Available Items Create Done 

 
In this example: 

• Select Type = ‘Fixed Ref’. 

• Select Projects = ‘Int 2 Fashion and Textile Technology’. 

• Select Reference = ‘ItemSpecNo’. 

• Select Value = ‘1’. 
 
‘Available Items’ will display the number of items that match the criteria specified, in this case, 
14. 
 

• Click ‘Create’. 

• Click ‘Done’.  
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(b) Free Text 
 

 Select Type Select Projects Select Reference Select Value 

 

  
 

 Available Items Create Done 

 
In this example: 

• Select Type = ‘Free Text’. 

• Select Projects = ‘Int 2 Fashion and Textile Technology’. 

• Select Reference = ‘Keywords’. 

• Select Value = ‘Cotton’. 
 
As this is a free text search you should uncheck the ‘Case sensitive’ checkbox and choose Contains 
from the drop-down menu. If you need to filter items that don’t contain a particular value, you 
can check the ‘NOT’ checkbox. 
 
‘Available Items’ will display the number of items that match the criteria specified, in this case, 
1. 
 

• Click ‘Create’. 

• Click ‘Done’. 
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(c) Free Text – Year Coding 
 
When selecting items to include in an assessment you may wish to filter out items used in several 
preceding years.  The following illustrates the parameters to use to do this. 
 

 Select Type Select Projects Select Reference Select Value 

 

  
 

 Available Items Create Done 

 
Select Type = ‘Free Text’. 
Select Projects = ‘PA Training Project’. 
Select Reference = ‘Coding’. 
Select Value = ‘aaaa’, drop down menu ‘Contains’, ‘NOT’ checkbox checked. 
 
‘Available Items’ will display the number of items that match the criteria specified, in this case, 
3. 
 

• Click ‘Create’. 
 
If required, further parameters can be created to allow filtering out of multiple years. 
 

• Amend Select Value. 

• Click ‘Create’. 
 

• Click ‘Done’. 
 
Once you have selected all your parameters, ensure you choose ‘Match all parameters’ on the 
Search Results screen. 
 
Details of the year coding used for each subject will be provided to Principal Assessors by NQ 
Assessment. 

  



 
Version 2.4 Page 35 

(d) Specific Item 
 

 Select Type Browse  

 

  
 

 Available Items Create Done 

 
In this example: 

• Select Type = ‘Specific Item’. 

• Click ‘Browse’. 
 

 
 

 OK 

 

• To expand a folder, click on the arrow to the left-hand side. Click on the item you wish to 
select and then click ‘OK’. 

 
‘Available Items’ will display the number of items that match the criteria specified; this will always 
be 1. 
 

• Click ‘Create’. 

• Click ‘Done’.  
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(e) Item Name 
 

 Select Type Select Projects Select Value 

 

  
 

 Available Items Create Done 

 
In this example: 

• Select Type = ‘Item Name’. 

• Select Projects = ‘Int 2 Fashion and Textile Technology’. 

• Select Value = ‘JG’. 
 
As this is a free text search you should uncheck the ‘Case sensitive’ checkbox and choose Contains 
from the drop-down menu. If you need to filter items that don’t contain a particular value, you 
can check the ‘NOT’ checkbox. 
 
‘Available Items’ will display the number of items that match the criteria specified, in this case, 
9. 
 

• Click ‘Create’. 

• Click ‘Done’. 
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(f) Folder Reference 
 

 Select Type Browse  

 

 
 

 Available Items Create Done 

 
In this example: 

• Select Type = ‘Folder Reference’. 

• Click ‘Browse’. 
 

 
 

 OK 

 

• To expand a folder, click on the arrow to the left-hand side. Click on the folder you wish to 
select and then click ‘OK’. 

 
‘Available Items’ will display the number of items that match the criteria specified, in this case, 
6. 
 

• Click ‘Create’. 

• Click ‘Done’.  
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(g) Workflow Status 
 
 

 Select Type Select Project Select Value 

 

 
 

 Available Items Create Done 

 
 
In this example: 

• Select Type = ‘Workflow Status’. 

• Select Project = ‘Fashion and Textile Technology’ 

• Select Value = ‘Released’ 
 
‘Available Items’ will display the number of items that match the criteria specified, in this case, 
31. 
 

• Click ‘Create’. 

• Click ‘Done’. 
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9. Appendix – Troubleshooting 
 
Issue 

• You haven’t received your password to access ItemBank. 
 
Resolution 

• Check the junk or spam filter in your e-mail. As an auto-generated e-mail your e-mail provider 
may incorrectly identify it as a spam e-mail. 

 
 
Issue 

• Some elements of ItemBank appear to be cut off the screen or buttons appear to be 
inaccessible. 

 
Resolution 

• Check that your screen resolution is set to the minimum recommended in the computer 
specification (1024 x 768). 

• Before logging in to ItemBank, set your Internet browser to full screen, commonly accessed by 
pressing F11 on your keyboard. (Once you have finished using ItemBank press F11 again to exit 
full screen mode.) 

 
 
Issue 

• Cannot find the amended question paper or marking instructions which you have saved. 
 
Resolution 

• Check the recent files list in Microsoft Word, commonly accessed via the File menu or Office 
menu depending on what version of Microsoft Word you are using. 

• Search for the file on your computer. The filename will be in the format: 
Year Subject Level_Exam Paper/Mark Scheme_Version Number.docx 
eg, 2014 Classical Greek National 5_Exam Paper_1.docx 

 
 
Issue 

• When entering the username and password you are getting a “User validation failed” 
message 

 
Resolution 

• Check that you have entered your username and password correctly. The password is case 
sensitive so check you haven’t got Caps Lock switched on. 

• Check that you have entered the correct web address for ItemBank. The web address should 
contain the word itembank and the login screen should show ItemBank as in the following 
screenshot: 
 

 


